Contents

Introduction ........................................................................................................................................ 1

1 Taking Photos for HDR ................................................................................................................. 2
  1.1 Setting up the Camera ............................................................................................................. 3
  1.2 Selecting the Exposures .......................................................................................................... 3
  1.3 Using Film-Based Cameras .................................................................................................... 4

2 Loading and Pre-Processing Images .......................................................................................... 5
  2.1 Merging Bracketed Images .................................................................................................... 5
    2.1.1 Loading Bracketed Images ............................................................................................. 5
    2.1.2 General Pre-Processing Options ..................................................................................... 7
    2.1.3 Using the Selective Deghosting Tool ............................................................................. 8
    2.1.4 Pre-Processing Options for RAW Files .......................................................................... 10
  2.2 Working with Single Image Files ........................................................................................... 11
    2.2.1 Options for Single RAW Image Files ............................................................................. 11

3 Adjusting Images Using Tone Mapping or Exposure Fusion ..................................................... 12
  3.1 Image Adjustment Workflow .................................................................................................. 12
  3.2 Image Adjustment Windows ................................................................................................ 13
    3.2.1 Preview Window ............................................................................................................. 13
    3.2.2 Preset Thumbnails Panel ............................................................................................... 14
  3.3 Tone Mapping Details Enhancer Settings .............................................................................. 16
  3.4 Tone Mapping Tone Compressor Settings ............................................................................ 17
  3.5 Exposure Fusion Adjust Settings .......................................................................................... 18
  3.6 Exposure Fusion Intensive Settings ....................................................................................... 18
  3.7 Replace Selection with Source ............................................................................................ 19
    3.7.1 Selecting the Area to be Replaced ................................................................................. 19
    3.7.2 Fitting the Selection to the Area's Edges ...................................................................... 20
    3.7.3 Replacing the Selected Area ......................................................................................... 21

4 Automating with Batch Processing ............................................................................................ 22
  4.1 Batch Processing Bracketed Photos ....................................................................................... 22
    4.1.1 Using Batch Processing .................................................................................................. 22
    4.1.2 Batch Processing Settings ............................................................................................. 23
    4.1.3 Batch Processing Subfolders ......................................................................................... 24
    4.1.4 Advanced Options ......................................................................................................... 24
  4.2 Batch Processing Single Image Files ..................................................................................... 25

5 Tips and Techniques .................................................................................................................. 26
  5.1 Integrating Lightroom with Photomatix Pro ........................................................................ 26
  5.2 Processing RAW files in Third-Party RAW Converters ......................................................... 26
  5.3 Dealing with Noise ............................................................................................................... 27
  5.4 Photomatix Pro and Color Management ............................................................................. 27

Glossary ............................................................................................................................................ 28

Resources ........................................................................................................................................ 30
Introduction

Photomatix Pro works with photographs of the same scene taken under different exposure settings, often called “bracketed” images in reference to the auto-bracketing exposure functions available on many camera models. If you have not taken bracketed photos, you can start using Photomatix Pro with the sample images available from the download page of the Photomatix Pro website – http://www.hdrsoft.com. Use the information in Section 1, Taking Photos for HDR to try Photomatix with your own images.

This manual contains information about how to use Photomatix Pro to adjust images using different Tone Mapping or Exposure Fusion methods. All of the methods are accessed from one window within the application, making it easy to try different settings to achieve the results you want. Refer to Section 2, Loading and Pre-Processing Images and Section 3, Adjusting Images Using Tone Mapping or Exposure Fusion for detailed information about the different settings that are available.
1 Taking Photos for HDR

The shooting phase is essential for getting good results with Photomatix. To photograph a high contrast scene, you need to take several exposures in order to capture information in both the highlights and the shadows of the scene. The exposures taken must properly cover the dynamic range of the scene, especially the shadows.

The number of photos you need depends on the scene. It also depends on the Exposure Value (EV) spacing separating the photos. If you take them in one-EV steps (e.g., -1, 0, +1 EV), you will need more photos than if you take them in two-EV steps (e.g., -2, 0, +2 EV). We recommend shooting in two-EV steps whenever possible.

High contrast scenes can be grouped into roughly two types depending on their dynamic range:

- **Medium dynamic range scene**: Most landscapes and other types of outdoor scenes fall into this category. Three exposures taken in two-EV steps (i.e. –2, 0, +2 EV), or five exposures taken in one-EV steps, are usually sufficient for this type of scene.

- **High dynamic range scene**: A typical example is the interior of a room with a view outside the window on a sunny day. You need to take at least five exposures in two-EV steps (or nine exposures in one-EV steps) to capture this type of scene, but you may need more. Taking the exposures manually is recommended in these cases.

The source photographs for HDR processing can be taken with digital or film-based cameras. The only requirement is that the exposure can be adjusted when taking pictures. If you use a film-based camera, you will need to scan the photographs into your computer before processing them (refer to Section 1.3).
1.1 Setting up the Camera

- Set your camera to Aperture priority ("A" setting) so that only the shutter speed varies between the exposures.
- Select a low ISO, such as ISO 100 or lower.
- Turn off the flash. The flash may try to balance the exposure of all the images, when the goal is a range of exposures.
- Mount the camera on a tripod whenever possible. Even though Photomatix Pro offers automatic alignment of hand-held photos, using a tripod is always better.

DSLR cameras and some compact digital cameras offer Automatic Exposure Bracketing (AEB). This enables you to automatically take three or more exposures in a row; one at the proper exposure, one or more underexposed, and one or more overexposed. Follow these steps if your camera offers AEB mode:

- Select the Continuous shooting mode on the camera’s drive setting. Consult your camera manual for model-specific instructions for using this setting.
- Set the camera to Auto Exposure Bracketing (AEB)
- If possible, use the camera’s self-timer setting, a cable release or a wireless shutter release to minimize camera shake.
- Set the exposure increment to +/- 2 for optimal exposure range. If your camera does not offer +/- 2 exposure increments, select the maximum possible. Consult the camera manual for model-specific instructions for choosing this setting.

1.2 Selecting the Exposures

To get good results with HDR processing, your capture sequence must include photos that correctly expose highlights and photos that correctly expose shadows. The latter is especially important to prevent noise from showing in the processed HDR image.

In the lightest photo of the sequence, the darkest shadows should be at least in the mid-tones. To check this, use your camera’s histogram preview in playback mode. In your most overexposed photo, the left part of the histogram should be empty until 1/3rd of the histogram’s width. If this is not the case, add one or more photos taken with longer exposure times. Another option is to re-shoot the exposure sequence with the normal exposure set one or more EVs higher if your most underexposed image in the exposure sequence was too dark. This is the case when the histogram of your darkest image is completely empty on the right half.

The number of exposures needed depends on the dynamic range of the scene, in addition to the exposure increment. For most outdoor scenes, three exposures taken at +/- 2 exposure increments is sufficient, provided the scene does not include the sun. However, for the interior of a room with a bright view out the window, you will need at least five images taken with an exposure increment of +/- 2, or nine images taken with an exposure increment of +/- 1.

In scenes with extreme differences between light and dark details, you should change the exposures manually to ensure you capture a wide enough range to cover your scene.
1.3 Using Film-Based Cameras

- Follow the camera setup listed at the top of Section 1.1 and the tips on selecting exposures in Section 1.2. Keep in mind that you will not have the option of previewing the live histogram to determine your exposure range.
- Scan film or slides, not prints. Photo labs attempt to make the best print from each of your source images, and you will not achieve good results scanning these for HDR generation.
- Turn off your scanner’s auto-exposure options. This allows you to manually control the exposure.
- Make sure you select the Align images option in Photomatix Pro when combining your images.
2  Loading and Pre-Processing Images

This section describes how to load and merge bracketed image files of a scene taken under different exposure settings as well as how to load single images into Photomatix Pro.

2.1  Merging Bracketed Images

Photomatix Pro merges bracketed images that are in 8 bit or 16 bits/channel mode, as well as Camera RAW files.

Supported file types include JPEG, TIFF, PSD, DNG, and RAW files from many camera models. The list of supported camera models for RAW files is updated frequently to include the newest camera models. You can check the the Photomatix Pro FAQ page on the HDRsoft website at http://www.hdrsoft.com/support/raw.html to determine whether or not your camera model is supported.

2.1.1  Loading Bracketed Images

To load bracketed image files, do one of the following:

• Drag and drop the files into Photomatix Pro
• Use the Workflow Shortcuts area or the File menu to load the files

Dragging and Dropping Bracketed Image Files

To drag and drop a group of image files to Photomatix Pro:

• Windows: Drag the files from Windows Explorer and drop them on the open Photomatix Pro program.
• Macintosh: Drag the files from the Finder and drop them on the Photomatix Pro icon on your Dock.

Note

The term “bracketed images” refers to images of the same scene taken under different exposure settings. This manual uses the term “bracketed images” to simplify how these images are defined. It also applies to the case when you have not used the Automatic Exposure Bracketing function of the camera to take the exposures.

Note

Drag the image files for the exposure sequence at the same time, so the files are properly processed by the merge.

Note

Newer camera models may not be supported by older versions of Photomatix Pro. To ensure your camera is supported, upgrade to the latest version.

Note

If you have Lightroom, use the Lightroom Export Plug-in to load images into Photomatix Pro. Refer to Section 5 for more information.
Using the Workflow Area or the File Menu

To load images using the Workflow Shortcuts panel or the File menu:

1. Click **Load Bracketed Photos** in the **Workflow Shortcuts** area
   OR
   Select **Load Bracketed Photos** from the **File** menu.

The **Loading bracketed photos** dialog displays.

![Loading bracketed photos dialog](image)

2. Drag and drop the files into the **Loading bracketed photos** dialog
   OR
   Click **Browse**. A dialog displays prompting for location of the files.

3. Select the files to load, using one of the following methods:
   - Click the first file, then press and hold the Control key (Windows) or Command key (Mac). While holding down the Control or Command key, click each of the other files you wish to select.
   - Click the first file, then press and hold the Shift key. While holding the Shift key down click the last file. This will select all the files in-between the first and last file.

4. Click **Open** (Windows) or **Select** (Mac).
5. Click **OK** to pre-process the files.

**Entering Exposure Values**

If the exposure information cannot be located in the metadata of the image files, Photomatix Pro displays a dialog prompting for input of the relative **Exposure Values** for each image. Photomatix Pro also displays this dialog if two or more source images share the same exposure information.
2.1.2  General Pre-Processing Options

After the bracketed images are selected, the pre-processing settings for the images may be customized before the 32-bit HDR image is generated. Refer to the following list for a description of the available options for merging bracketed images:

### Alignment Options

The **Align source images** option is checked by default. It corrects misalignment problems when the camera moves slightly between the bracketed frames. Hand-held photographs and even some images shot with a tripod have camera movement.

- **By correcting horizontal and vertical shifts**: Faster method, but only corrects for translation movements.
- **By matching features**: Corrects for rotation, translation and scaling differences, as well as perspective distortion if selected. Recommended for hand-held shots.
- **Include perspective correction**: Requests that the alignment by matching features corrects for perspective distortion in addition to correcting for translation, rotation and scaling differences.
- **Crop aligned images**: Checked by default. Removes the unused borders that appear when the images are shifted to correct for mis-registration. Leave this box unchecked if you need the resulting image to have the same width and height as the source images.
- **Maximum shift**: Sets the maximum mis-registration shift that the alignment attempts to correct for, and is expressed as a percentage of the image dimensions. This setting does not need adjusting in most cases. A situation when adjusting this setting may be useful is when the camera barely moved between the bracketed shots. In this case, setting a maximum shift lower than 12% will restrict the number of alignment corrections searched, thereby reducing the risk of selecting an improper alignment correction.

### Deghosting Options

The **Remove ghosts** option addresses the problem of artifacts that appear when combining images of a dynamic scene. For example, if the moving subjects are people walking, the people appear multiple times in the combined image as if there were “ghosts”. This is why artifacts arising from movements in the scene are commonly referred to as “ghosting” and the attempt to eliminate them as “deghosting”.

- **With selective deghosting tool**: Activates the Selective Deghosting Tool, which lets you select ghosted regions and choose the exposure used for each ghosted region.
- **Automatically**: Automatically detects ghosted zones in the merged image.

---

Note

The Align source images option should not be checked when your source images are stitched panoramas or when they are “fake exposures” derived from a single RAW file.

Note

The deghosting option is effective for images processed with Tone Mapping or with the default Exposure Fusion method. It is not effective for the other Exposure Fusion methods.
• **Detection**: Sets the criteria for determining if a pixel is or is not ghosted when using automatic deghosting.

**Noise Reduction Options**

The **Reduce noise** option processes source photos with high-quality noise reduction and is recommended when processing RAW files directly in Photomatix.

• **Strength**: Increases or decreases the strength of the noise reduction relative to the automatically determined value based on the noise level in the image. Values range from 50% to 150%.

**Reduce Chromatic Aberrations**

The **Reduce Chromatic Aberrations** option automatically corrects color fringing due to chromatic aberrations of the lens. Checking this option is recommended, given that chromatic aberrations tend to show around high contrast edges, and are particularly an issue for HDR images.

**2.1.3 Using the Selective Deghosting Tool**

The **Selective Deghosting Tool** lets you select the portions of the image that require processing for removing ghosting due to movement of elements in the image. Photomatix Pro uses the image that it deems the best exposed for the selected area as the default image for deghosting. You may change the image to one of your choice using the tool.

Select **With selective deghosting tool** from the Remove ghosts preprocessing options to access the Selective Deghosting tool. To use the Selective Deghosting tool, click and drag the mouse to draw a lasso around the region that requires deghosting. Ensure the selection is a fully closed loop with a dashed line.
Right-click (Windows) or control-click (Mac) inside the selected region and select **Mark selection as ghosted area** from the pop-up menu. The line around the selected region changes from dashed to solid to indicate that the area has been selected for deghosting.

At any time, use the **Brightness** slider to increase or decrease the brightness of the image. Or, use the Zoom slider to zoom in and out.

If necessary, you can remove a region from the deghosting selection. Control click or right click inside an already marked region and click **Remove selection** from the pop-up menu.

You may also change the image used as the default image for deghosting. Control-click or right-click inside an already marked region and click **Set another photo for selection** from the pop-up menu. The tool displays a pop-up menu with a list of the available exposures. Select an exposure value from the list.

---

**Note**

The photo that the tool automatically sets for the selection is not always the most appropriate exposure choice. It is thus a good idea to check whether changing to another photo produces a better deghosting result.
2.1.4 Pre-Processing Options for RAW Files

Photomatix Pro offers additional pre-processing options for RAW files.

The **White Balance** options let you change the white balance, if desired, and preview the effect of changing it. The default value is "As Shot", which reads the white balance setting from the EXIF metadata. To adjust the white balance, select a pre-defined value from the White Balance drop-down list or type a color temperature in Kelvin in the text box.

Click **Preview sample** to view the effect of the white balance change on the source image.

The **Color primaries based on** drop-down list provides options for converting the RAW data from the camera’s native color space to the display profile of the selected value. AdobeRGB is the default value and is appropriate when you want to print the resulting image. If you would like to display the resulting image only on the web and do not intend to print it, then select sRGB to avoid having to convert the image from AdobeRGB to sRGB.

To view a preview of the deghosted image, click **Preview deghosting**. To make more selections or modify existing regions selected for deghosting, click **Return to selection mode**. You may continue selecting regions of the image and previewing the results until you are satisfied with the results.

Click **OK** to apply the deghosting to the image or click **Cancel** to stop merging the images.
2.2 Working with Single Image Files

Photomatix Pro supports Tone Mapping of single image files. To load a single image file:

1. Drag the image file to the Photomatix Pro application (Windows) or icon on your Dock (Mac).
   OR
   Select Open from the File menu. A file browser window displays. Navigate to the file and open it.

2. To process the image using Tone Mapping, click Tone Mapping from the Workflow Shortcut bar.

   If the file is a JPG, a dialog will show to let you decide whether to reduce the noise on your image before tone mapping. If desired, check Do not ask me again to skip this dialog and use your Yes or No selection for all single JPGs that you process with Tone Mapping. If you need to re-enable the dialog later, access the Photomatix Pro Preferences to change the setting. The Preferences are available from the View menu (Windows) or Photomatix Pro menu (Mac).

2.2.1 Options for Single RAW Image Files

When your single image is a RAW file, Photomatix must first convert the RAW data. The following options are available for pre-processing the RAW data.

The Reduce noise option processes the converted RAW file with high-quality noise reduction. It is checked by default as reducing noise is always recommended when processing RAW files. The Strength slider lets you increase or decrease the strength of the noise reduction relative to the automatically determined value based on the noise level in the image. Values range from 50% to 150%.

The Reduce chromatic aberrations option automatically corrects color fringing due to chromatic aberrations of the lens.

The White Balance options let you change the white balance, if desired, and preview the effect of changing it. The default value is "As Shot", which reads the white balance setting from the EXIF metadata. To adjust the white balance, select a pre-defined value from the White Balance drop-down list or type a color temperature in Kelvin in the text box.

Click Preview sample to view the effect of the white balance change on the source image.

The Color Space drop-down list provides options for converting the RAW data from the camera's native color space to the display profile of the selected value. AdobeRGB is the default value and is appropriate when you want to print the resulting image. If you do not intend to print the image, select sRGB for web-only images to avoid having to convert the image from AdobeRGB to sRGB.
3 Adjusting Images Using Tone Mapping or Exposure Fusion

Photomatix Pro provides access to HDR Tone Mapping and Exposure Fusion methods in one window. The window includes a preview, so you can see how adjustments to settings or changing the adjustment method affect the result. This section describes the workflow for adjusting and processing images and details the Tone Mapping and Exposure Fusion settings.

3.1 Image Adjustment Workflow

After you have preprocessed and merged your source images (or opened a single image file), the next steps are:

1. Adjust the image to your liking: Choose a style you like from the thumbnails listed on the Presets window. You can then refine the effect by adjusting the controls in the Settings window. Refer to Sections 3.3 through 3.6 for detailed descriptions of the settings.

   Refer to Section 3.2.2 for more information about using presets.

2. Process the image: When you are satisfied with the adjustments, click on the Process button located at the bottom of the Adjustment window to process the image at original resolution with the selected settings.

3. Finishing Touch: Once you have processed the image and before saving it, you may use the options on the Finishing Touch palette in order to increase the contrast of your image, sharpen it, or adjust the saturation of individual colors.

4. Save the image: When you have processed the image, you can save it. Select File -> Save As. Navigate to the folder where the file should be stored. Use the default file name or enter a name in the File name field. Select a file type:

   • TIFF – 16bit: best choice for further processing
   • TIFF – 8bit: for use in applications that cannot work with 16 bit, or for avoiding too large a file size on disk
   • JPEG: for use on the web without further editing

If you would like to automatically view the file with a photo viewing application after saving, you can click Open Saved Images with. Accept the default program or select a program from the drop-down list. If a desired program is not on the list, click Add application, navigate to the folder containing the program, select the program and click Open.

Note

Exposure Fusion is only available when bracketed photos are loaded. When a single image is loaded only tone mapping is available.

Viewing image adjustment settings

The settings are automatically embedded in the saved processed image. To view the settings, click View Settings from the Workflow Shortcuts bar.

Note

To undo changes made during the adjustment process, click the undo arrow at the bottom of the adjustments panel. To redo adjustments, click the redo arrow to reapply changes.
Undoing Adjustments and Reprocessing an Image

After processing an image, you can return to **Tone Mapping** or **Exposure Fusion** to make further changes if you are not satisfied with the results.

You may also undo processing, before returning to **Tone Mapping** or **Exposure Fusion**:

- Select **Undo Tone Mapping** or **Undo Exposure Fusion** from the Process menu (Windows) or Edit menu (Macintosh). Photomatix Pro returns the image to its original state. If you post-processed with the **Finishing Touch** options, then first select **Undo Finishing Touch**.

- Click **Tone Mapping/Fusion** from the Workflow Shortcut bar or select **Tone Mapping/Fusion** to return to the image adjustment window.

### 3.2 Image Adjustment Windows

#### 3.2.1 Preview Window

The **Preview Window** provides a preview of the tone mapped or fused image as you adjust the settings, as well as the following controls.

- **Scaling Slider**: Zooms in or out the refreshed preview from 50% to 150%. The preview is not recalculated but quickly scaled. Each time **Fit** or one of the **Magnifier** icons is clicked the preview is recalculated and the **Zoom Slider** resets to 100%.

- **Fit**: Resizes the preview to fill the available space on the program’s main window (Windows) or your screen (Macintosh).

- **Magnifier icons +/-**: Increases or decreases the preview image by 20% and recalculates it at the new size.

- **Preview**: The Preview checkbox quickly toggles between a preview of the tone mapped image and the “normal” exposure (0EV) of the set. This is helpful to compare the effects of the image adjustments.

- **Selection Mode**: Checking the selection mode checkbox enables you to select an area of the preview and replace it with one of the source images. See section 3.7 for details.

- **Floating Histogram**: The tone mapping Histogram is a floating window that contains four selectable tabs to improve analysis of the image: **Luminance**, **Red**, **Green**, and **Blue**. In addition, move the mouse back and forth across the histogram to display **Level**, **Count**, and **Percentile** information. If the histogram is turned off, enable it by selecting **8-bit Histogram** from the View menu.

---

**Note**

For the Details Enhancer method of Tone Mapping and the Adjust method of Exposure Fusion, the preview is not always an accurate representation of the final tone mapped image.
3.2.2 Preset Thumbnails Panel

The Presets panel lists the available presets, showing a thumbnail preview of the effect of the preset on your image. When you click on a preset thumbnail, the preview window is refreshed to show the result of processing your image with the settings of the selected preset.

By default, the panel displays one column of small thumbnails. Click on the “plus” icon on the top of the panel to display the thumbnails at a larger size. Click on the icon on the top right of the panel to display the thumbnails in two columns.

If you prefer that the Presets panel does not show by default, you can set this as an option in Preferences. You can access the Photomatix Pro Preferences from the View menu (Windows) or Photomatix Pro menu (Mac).

There are two types of presets, built-in and custom.

Built-in Presets

Built-in presets are “factory” presets that are provided with the software. Photomatix Pro offers 32 built-in presets when you are processing bracketed photos, 23 when you are processing a single file.

The pop-up menu at the top left of the Preset Thumbnails panel lets you view a smaller grouping of built-in presets. You can list the presets by category by selecting the name of the category, or choose to view a subset of presets from all categories by selecting the “Short List” item.

There are four categories of built-in presets, corresponding to either a style or type of image. The categories are: **Realistic**, **Artistic**, **Black & White** and **Fusion**. The **Fusion** category lists presets processed with Exposure Fusion methods and is only available when you load bracketed photos.
Custom Presets

Custom presets are presets that you saved when adjusting your images, or that you imported from presets created by other Photomatix users.

To access custom presets, click on the My Presets tab located at bottom of the Preset Thumbnails panel. To create your own custom presets, refer to the Saving Custom Presets paragraph below. You can also import custom presets created by other Photomatix users that you downloaded to your computer as XMP files. To import the presets, select the item "Import Presets..." on the pop-up menu on the top left of the Preset Thumbnails panel, and browse to the location on your computer where you downloaded the XMP preset files.

Saving Custom Presets

There are two ways to save custom presets as an XMP file for future use; during the image adjustment phase or after Tone Mapping or Exposure Fusion is complete.

To save custom presets during image adjustment:

1. In the Adjustments panel, click the Presets drop-down list.
2. Select Save Settings from the list.
3. Enter a name for the preset in the File name field and click Save.

To save the processing selections as a preset after Tone Mapping or Exposure Fusion processing:

1. Click Save Settings from the Workflow Shortcuts bar or select Save Settings from the File menu.
   A dialog prompts for the file name.
2. Enter the file name and click OK.

Note

If you save the preset in the default location (which is the Presets folder of the Photomatix Pro application), the preset is automatically added to the Presets combo-box list, and also shows on the “My Presets” tab of the Preset Thumbnails Panel.
3.3 Tone Mapping Details Enhancer Settings

General Settings

- **Strength**: Affects the degree to which contrast and detail are enhanced in the image. A value of 100 gives the maximum amount of enhancement. To get a more natural effect, move the slider to the left. The default value is 70.

- **Color Saturation**: Controls the saturation of the RGB color channels. The greater the saturation, the more intense the color. Move the slider right or left to change the setting. A value of 0 produces a grayscale image. The value affects each color channel equally. The default value is 46.

- **Luminosity**: Controls the compression of the tonal range, which has the effect of adjusting the global luminosity level. Move the slider to the right to boost shadow details and brighten the image. Move it to the left to give a more “natural” look to the resulting image. The default value is 0.

- **Detail Contrast**: Controls the amount of contrast applied to detail in the image. Move the slider to the right to increase the contrast of the details and give a sharper look to the image. Note that increasing the contrast also has a darkening effect. Move the slider to the left to decrease the contrast of details and brighten the image.

- **Lighting Adjustments**: Affects the overall ‘look’, controlling the extent to which the image looks natural or surreal. When the Lighting Effects Mode box is unchecked, move the slider to the right to make the image look more natural and to the left to make it look more ‘painterly’ or ‘surreal’.

- **Lighting Effects Mode**: The checkbox lets you switch between two modes for the Lighting Adjustments setting, where each mode produces slightly different results. Checking the box tends to produce results with a type of ‘Magic Light’ effect. Note that finer control is not possible in Lighting Effects mode.

More Options

- **Smooth Highlights**: Reduces the contrast enhancements in the highlights. The value of the slider sets how much of the highlights range is affected. This control is useful for preventing white highlights from turning grey or uniform light blue skies becoming dark blue-grey. It is also useful for reducing halos around objects placed against bright backgrounds. The default value is 0.

- **White Point – Black Point**: These sliders control how the minimum and maximum values of the tone mapped image are set. Moving the sliders to the right increases global contrast. Moving them to the left reduces clipping at the extremes. The White Point slider sets the value for the maximum of the tone mapped. The Black Point slider sets the value for the minimum of the tone mapped image. The default value is 0.25% for the White Point setting and 0% for the Black Point setting.

- **Gamma**: Adjusts the mid-tone of the tone mapped image, brightening or darkening the image globally. The default value is 1.0.

- **Temperature**: Adjusts the color temperature of the tone mapped image relative to the temperature of the HDR source image. Move the slider to the right for a warmer, more yellow-orange tinted look. Move the slider to the left for a colder, more bluish look. A value of 0 (default) preserves the original color temperature of the HDR source image.
### Advanced Options

- **Micro-smoothing**: Smoothes local detail enhancements. This has the effect of reducing noise in the sky, for instance, and tends to give a “cleaner” look to the resulting image. The default value is 2.

  *Important note*: The Loupe may not properly show the effect of the Micro-smoothing setting when the area magnified is uniform. If you want to see the effect of the Micro-smoothing setting at 100% resolution on a uniform area such as the sky, you will have to select an area that contains an object in the scene in addition to the sky.

- **Saturation Highlights**: Adjusts the color saturation of the highlights relative to the color saturation set with the Color Saturation slider. Values higher than 0 increase the color saturation in the highlights. Values lower than 0 decrease it. The default value is 0.

- **Saturation Shadows**: Adjusts the color saturation of the shadows relative to the color saturation set with the Color Saturation slider. Values higher than zero increase the color saturation in the shadows. Values lower than zero decrease it. The default value is 0.

- **Shadows Smoothness**: Reduces the contrast enhancements in the shadows. The value of the slider sets how much of the shadows range is affected. The default value is 0.

- **Shadows Clipping**: The value of the slider sets how much of the shadows range is clipped. This control may be useful to cut out noise in the dark area of a photo taken in a low-light situation. The default value is 0.

- **360º image**: Checking this option eliminates the seam between the left and right sides of a panorama viewed in a 360º panoramic viewer. The seam would otherwise show because Details Enhancer takes into account local contrast, assigning different tonal values to the right and left parts of the image. The default value is unchecked. Note that this option is not enabled when the image is in portrait mode, as the option is intended for panoramas.

### 3.4 Tone Mapping Tone Compressor Settings

- **Brightness**: Adjusts the overall brightness of the tone mapped image. The default value is 0.

- **Tonal Range Compression**: Controls the compression of the tonal range. Move the slider to the right to shift both shadows and highlights toward the mid-tones in the tone mapped image. The default value is 0.

- **Contrast Adaptation**: Adjusts the influence of the average brightness in relation to the intensity of the processed pixel. Move the slider to the right to create more pronounced colors. Move the slider to the left to create a more “natural” look. The default value is 0.

- **White Point – Black Point**: These sliders control how the minimum and maximum values of the tone mapped image are set. Moving the sliders to the right increases global contrast. Moving them to the left reduces clipping at the extremes. The White Point slider sets the value for the maximum of the tone mapped image (pure white, or level 255). The Black Point slider sets the value for the minimum of the tone mapped image (pure black, or level 0). The default values are 0.
• **Temperature**: Adjusts the color temperature of the tone mapped image relative to the temperature of the HDR source image. Move the slider to the right for a warmer, more yellow-orange colored look. Move it to the left for a colder, more bluish look. A value of 0 (default) preserves the original color temperature of the HDR source image.

• **Saturation**: Adjusts the color saturation of the tone mapped image. The greater the saturation, the more intense the color. The value affects each color channel equally. The default value is 0.

3.5 **Fusion/Natural Settings**

• **Strength**: Sets by how much local contrast is accentuated. Moving the slider to the right tends to brighten the shadows and to show more details in the highlights. Moving the slider to the left produces a more 'natural' effect. The default value is 0.

• **Blending Point**: Adjusts the weighting given to the underexposed versus overexposed images. When you move the slider to the right, overexposed images are favored, which has the effect of brightening the image. The reverse applies when you move the slider to the left. The default value is 0.

• **Shadows**: Adjusts the brightness of the shadows. The default value is 0.

• **Local Contrast**: Increases the contrast and sharpness of details in the image. Increasing local contrast may have the side effect of making noise more visible, and of creating thin halo effects around strong luminosity edges. Values near the maximum tend to give a surreal look to the image. The default value is 2.

• **Color Saturation**: Adjusts the saturation of the color channels. The greater the saturation, the more intense the color. A value of -10 produces a grayscale image. The default value is 0.

• **White Clip**: Specifies how much the highlights are clipped. Move the slider to the right to increase contrast and remove details in the brightest highlights. The default value is 0.

• **Black Clip**: Specifies how much the shadows are clipped. Move the slider to the right to increase contrast but remove details in the darkest shadows. The default value is 0.

• **Mintone**: Positive values brighten the image but reduce the overall contrast. Negative values darken the image but increase overall contrast. The default value is 0.

• **360° Image**: Checking this option eliminates the seam between the left and right sides of a panorama viewed in a 360° panoramic viewer. The seam would otherwise show because Fusion Adjust takes into account local contrast, assigning different tonal values to the right and left parts of the image. The default value is unchecked.
3.6  Fusion/Intensive Settings

- **Strength**: Adjusts the strength of local contrast enhancements. The default value is 0.

- **Color Saturation**: Adjusts the saturation of the color channels. The default value is 0.

- **Radius**: Controls the area used to calculate the weighting of the source images. The default value is 70.

3.7  Replace Selection with Source

An HDR-processed image might look exactly the way you want, except for one area. For example, the sky might have more contrast or be darker than desired. The “Replace selection with source” feature lets you replace that area with the same area from any one of the source images, to bring the tonemapped or fused image closer to what you want.

3.7.1  Selecting the Area to be Replaced

To enable this feature, click the Selection Mode checkbox. The Polygonal Lasso is the default tool.

We recommend using the Polygonal tool, but you can use the Normal or Magnetic tool if you prefer. Selection works differently, depending on the tool.

- **Polygonal lasso**
  - Click to set the selection line’s starting point.
  - Move the mouse and click to create a straight segment, attached to the previous point. Repeat to create additional segments.
  - To close the selection, double-click, or single-click on the starting point.

- **Normal lasso**
  - Click and drag the mouse to draw a freehand selection.
  - Release the mouse button to close the selection.

- **Magnetic lasso**
  - Click and drag the mouse as with the Normal lasso. If an edge is within the Width setting, the selection path snaps to the edge.
  - To close the selection, double-click, or single-click on the starting point.
Choosing a Lasso

- The Polygonal lasso is ideal for areas with straight sides, and good for large areas (because you don’t have to hold down the mouse button).
- The Normal lasso is good for areas with curved sides. It’s not the best choice for large areas, because you have to hold down the mouse button as you drag.

3.7.2 Fitting the Selection to the Area’s Edges

The area to be replaced usually has at least one irregular border (such as the mountains in this sample photograph). It’s difficult to draw irregular borders exactly, and you don’t have to. You can draw approximate borders, and Photomatix will fit them for you by “finding the edges”.

Finding the edges

The borders of the area you want to replace are almost always at edges — large changes in brightness between adjacent pixels. In the sample photo, the transition between the light sky and the darker mountains is an edge.

Selecting the Attach to Edges checkbox causes Photomatix to search for an edge near the selection path you drew. The selection path is then redrawn along the edge — in this case, the mountains.
The Contrast setting (Low, Medium, High) determines whether a difference in brightness is large enough to be detected as an edge. The higher the setting, the greater the brightness difference has to be.

The Width box (next to the Attach to Edges box) sets the maximum distance Photomatix searches (in pixels) from the original selection path. If Photomatix finds an edge within the Width setting, the selection is redrawn to fit the edge. If Photomatix finds a border of the image, the selection is redrawn along the border.

Changing the Width or Contrast setting immediately redraws the selection path to reflect the new value.

To undo the edge fit, clear the Attach to Edges checkbox.

### 3.7.3 Replacing the Selected Area

Right-click (Windows) or control-click (Macintosh) anywhere within the selection. A contextual menu appears.

- If you loaded bracketed photos, the menu identifies them by their exposure difference, relative to the “normal” exposure. Click the photo at the EV you want.
- If you loaded a single image, click "Replace with source".

If you prefer not to see the lines marking your selection, uncheck the Selection Mode checkbox.

To discard the replacement and return to the initial preview, right-click within the selection and select the checkmarked item in the contextual menu.
4 Automating with Batch Processing

Use batch processing to automatically process image files. The batch processing tool saves time processing many images. Photomatix Pro offers two different batch modes:

- **Batch Bracketed Photos**: Processes bracketed sets using HDR Tone Mapping and/or Exposure Fusion all in one step, which can save you a lot of time when you have many series of photos to process.
- **Batch Single Photos**: Processes single image files using Tone Mapping.

4.1 Batch Processing Bracketed Photos

This section describes batch processing photos taken under multiple exposure settings.

![Batch Processing of bracketed photos](image)

4.1.1 Using Batch Processing

To batch process photos, select **Batch Processing** from the **Automate** menu or click **Batch Processing** from the **Workflow Shortcuts** panel.

To batch process series of bracketed photos, do the following:

1. Click the checkboxes on the left side of the window to select how the images should be processed.
2. Select the number of exposures to combine using the pull-down menu below the checkboxes. For example, select “3” if your bracketed shots consist of three exposures each, such as when you have taken for each scene one photo at median exposure, one underexposed and one overexposed.
3. In the Source area, select the folder where the bracketed photos are located. The files are arranged in alphabetical order. N files at a time are processed with N being the number specified in the previous step.

4. To save the results in a different folder than the folder containing the source photos, select the **Custom location** option in the Destination frame at the bottom right of the window.

OR

Accept the default of **Created under source folder** to create a subfolder with the name PhotomatixResults in the source image folder.

5. In the Destination frame, select the output file type. For JPG file output, select the quality from 0 to 100 from the drop-down list, with 100 yielding the largest file size.

6. Click **Naming and Output Options** if you would like to rename, resize, add contrast or sharpen the resulting images.

7. Click **Run** to start batch processing.

While the batch is running, processing status will display in the area below the **Run** button. When processing is complete, a link to the batch results will be displayed.

4.1.2 Batch Processing Settings

Use the Settings buttons to access HDR generation, Tone Mapping, and Exposure Fusion settings. Refer to Sections 3 and 4 for a description of these settings.

The following settings for generating HDR images are specific to batch processing:

- **Force Exposure Values spacing to**: Forces the EV spacing to the specified value. This option can be used when the exposure information is not available in the EXIF data, if two or more images have the same exposure information, or to force the EV spacing in all cases. In the latter case, the exposure information in the EXIF data is ignored.

- **Source images are linear (no tone curve applied)**: Intended for 16-bit TIFF files that have been converted from RAW files with a RAW converter that allows the image to be left in linear space. Very few RAW converters allow this, so only check this option if you are sure that the tonal values of the images are linear relative to the values of light captured.

- **Process strip by strip**: Check this option if the source images are large TIFF files. With this option, the HDR image file is created in several passes, processing and loading only one strip of each image into memory at a time. One strip is composed of a limited number of rows set to not exceed approximately 512 MB of RAM. This option is particularly useful when processing large panoramas. Note, though, that the alignment functions are not accessible when the “Process strip by strip” option is used.

---

**Note**

The term “linear” may have a different meaning depending on the RAW converter. For example, in Adobe Camera RAW, linear is relative to the Adobe RGB color space and not to the values of light. Therefore, do not select this option with files converted with Photoshop or Lightroom.
4.1.3 Batch Processing Subfolders

When your bracketed series are located in multiple folders, they can all be processed in one run, provided they are in subfolders of the same parent folder. To batch process multiple subfolders, check the Process subfolders option at bottom of the Source frame on the Batch Processing dialog and select sequentially. When “Process subfolders sequentially” is selected, the batch will process the bracketed image files in one subfolder and then move on to the next subfolder, all of which are contained in the main parent folder.

Processing Series of Photos with Varying Numbers of Exposures

When your bracketed sets are composed of varying numbers of exposures, you can use “Process subfolders sequentially” to combine the exposures in these sets in one batch run. Place each set in a separate subfolder, group the subfolders under a parent folder, select Process subfolders sequentially and select All from the pull-down menu for the number of images to process at one time.

Grouped by Exposures Option

If you are processing bracketed photos that will be part of a panorama, you may find it useful to be able to organize your photos in such a way that all exposures of the same levels are in the same folder. Let’s take as an example a panorama composed of four views that need to be stitched, with each view having been taken under three exposures: -2, 0, +2. You will then have 12 photos, and may need to place them in three separate subfolders composed of four photos each as follows:

- Subfolder1 contains the four photos for the panorama taken at EV -2
- Subfolder2 contains the four photos for the panorama taken at EV 0
- Subfolder3 contains the four photos for the panorama taken at EV +2

If you check “Process subfolders” and select “grouped by exposures”, the batch will combine the first file of Subfolder1 with the first file of Subfolder2 and the first file of Subfolder3. The batch will then combine the second file of Subfolder1 with the second file of Subfolder2 and the second file of Subfolder3, and so on for the third and fourth file of each subfolder.

4.1.4 Advanced Options

The following items are accessed from the Process frame when you click Advanced and click Options to configure automatic selection of bracketed image files.

Click Automatically detect the number of bracketed frames when processing a folder that contains files in addition to those in the set of bracketed frames or when the number of frames in the set varies. Photomatix Pro uses the metadata from the image files to perform automatic bracketed set detection.

- Specify a range using the two drop-down lists to automatically detect the number of bracketed frames.
- Move the Maximum time between two successive frames slider right or left to allow more or less time (read from the metadata). If your camera is set on continuous shooting and takes 3 frames/second, for example, then the slider could safely be set on 1 second.
4.2 Batch Processing Single Image Files

Photomatix Pro supports processing of single image files using tone mapping.

To batch process single image files:

1. Click *Batch Single Photos* from the Workflow Shortcut panel or select Batch Single Photos from the Automate menu.

2. To select the source folder that contains the files, click *Select Folder*.

3. Navigate to the folder that contains the files and click *OK*. Photomatix Pro displays the folder/path and the files in the folder.

4. To narrow down the files to process, if needed, hold down the Control key (Windows) or Command key (Mac) and click the files to process.

5. To process using the details enhancer, click *Tone Map with Details Enhancer*. Click *Settings* to customize how the files are processed.

AND / OR

To process using the tone compressor, click *Tone Map with Tone Compressor*. Click *Settings* to customize how the files are processed.

6. Click the checkboxes for noise reduction and CA correction, if needed.

7. To select a destination folder, click *Created under Source Folder* to save the images in the same folder as the source files.

OR

Click *Customized Location* to save the images in a different folder. Click *Choose* to select the destination folder. Photomatix Pro displays the folder location.

8. Select the output file type. For JPG file output, select the quality from 0 to 100 from the drop-down list, with 100 yielding the largest file size.

9. Click *Run*. The batch processing status displays.

When batch processing is complete, a link to the batch results will be displayed.
5 Tips and Techniques

This section provides tips for working with images in Photomatix Pro. More tips and techniques, and regularly updated information, can be found on the Photomatix Pro FAQ on the HDRsoft website at http://www.hdrsoft.com/support/faq_photomatix.html.

5.1 Integrating Lightroom and Photomatix Pro

You can export photos for processing in Photomatix Pro directly from Lightroom and reimport them back into the Lightroom library.

The Lightroom Export to Photomatix plug-in is free and included with the Photomatix Pro package. Please refer to the HDRsoft website at http://www.hdrsoft.com/download/lrplugin.html for installation instructions and a short tutorial showing how to use the Lightroom export plug-in for HDR processing in Photomatix Pro.

5.2 Processing RAW files in Third-Party RAW Converters

When using a third-party RAW converter, develop the RAW images with the following settings. As an example, the screenshots show the settings in Lightroom:

- **White Balance**: Use the same white balance for all source photos.
- **Basic settings**: Set all to zero. It is particularly important to set the Blacks setting to zero.
- **Curves**: Parametric and Point Curves should be linear.
- **Details**: Set the Sharpening Amount to zero.

![Basic Settings in Lightroom](image1)

![Working with curves in Lightroom](image2)

Note

To remove the watermark, Photomatix Pro requires that the image was not retouched after the watermark was added to it. If the brightness or contrast of the image was changed, or the image was cropped or resized, then Photomatix will not be able to remove the watermark.
5.3 Dealing with Noise

When you process your photos using Exposure Fusion, the fused image will tend to show less noise than the source images. This is because Exposure Fusion works by directly combining your bracketed photos, thus averaging out noise. However, when you create a 32-bit HDR image, your bracketed photos are assembled in linear space into an image that spans the full range of luminance values captured by the camera. If the lightest photo of your exposure sequence is not bright enough to expose the shadows of the scene, then the noise in the source photographs will be transferred to the HDR image. Noise in the HDR image will then be made more apparent by tone mapping, especially with Details Enhancer as this tone mapping method increases local details.

Though Photomatix Pro includes options to reduce noise, it is still always better to avoid noise at capture time as much as possible. There are two tips to ensure a low noise level:

• **Tip 1**: Set a low ISO setting (ISO 100 or lower) whenever possible
• **Tip 2**: Overexpose sufficiently, ensuring that the lightest image of your exposure sequence has its shadows in the mid-tones.

5.4 Photomatix Pro and Color Management

Photomatix Pro supports color management even if RAW files are processed. You should use the same working space in Photomatix Pro as you use in other image editors (e.g. Photoshop).

Photomatix supports the three most popular working spaces:

• **sRGB**: Use if the images are created only for the web.
• **Adobe RGB**: Popular working space for printing if extremely saturated colors are not used.
• **ProPhoto RGB**: Wide gamut working space. This should never be used for 8-bit images.

For all JPEG and TIFF files, Photomatix Pro preserves the color spaces of the source files.
**Glossary**

**AEB Mode**  
(Automatic Exposure Bracketing). DSLR cameras and some compact digital cameras offer this feature. It enables you to automatically take three or more exposures in a row: one at the proper exposure, one or more underexposed, and one or more overexposed.

**Aperture Priority**  
In Aperture Priority mode, you select the aperture and the camera determines the correct shutter speed for the available light. The shutter speed also depends on ISO sensitivity. This is the right mode for shooting bracketed shots for HDR (refer to Section 1 for more information).

**Bit**  
Bits represent digital data in computers. Digital Images are made of bits. A bit depth corresponds to $2^{\text{Bit Depth}}$ levels (e.g. 256 for 8-bit).

**Bit Depth**  
The number of bits a file type uses to represent a pixel's color at a given location in an image.

**Bracketed images**  
A group of photos taken with the Automatic Exposure Bracketing function of a camera, resulting in photos of the same scene taken with different exposures.

**Chromatic Aberration**  
As the lens focuses different wavelengths slightly differently, chromatic aberration occurs. For example, the purple fringing you often find around edges (leaves in front of a bright sky).

**Contrast Ratio**  
Another way to describe the dynamic range of a scene. The ratio between the darkest and brightest areas.

**dSLR**  
Digital Single Lens Reflex camera.

**Dynamic Range**  
In the context of HDR photography, the total range of light intensity in a scene, from the deepest shadows to the brightest highlights.

**EXIF**  
The Exchangeable Image File header contains information about the image, the camera, location, date and time and camera settings.

**Exposure**  
The amount of light that enters a camera for the length of time the shutter is open. Exposure depends on aperture and shutter speed, as well as the camera's sensitivity to light (controlled by the ISO). "Exposure" is also shorthand for a photograph or frame (a frame of film).

**Exposure Fusion**  
Combination of photos of the same scene taken under different exposure settings in such a way that highlight details are taken from the underexposed photos and shadow details from the overexposed ones.

**EV (Exposure Value)**  
A measure of exposure which is the equivalent of a stop. In the absolute sense, EV is defined as the exposure from a photo taken at 1 second, f/1, and ISO 100. In the relative sense, the correct exposure is normally 0 EV and any deviation is measured in positive or negative EV from that mark.

**HDR**  
High Dynamic Range.
### HDR Image
Strictly speaking, an HDR image is an intermediary image with 32 bits per color channel (96 bits per pixel). An HDR image is the result of merging photos of the same scene taken under different exposure settings and stored in special HDR image format. The 32-bit intermediary HDR image must be processed with tone mapping for proper display on standard monitors and prints. It has become very common to define "HDR image" as the result of processing the 32-bit HDR image with tone mapping, i.e. the tone mapped output, but this is not technically correct.

### Histogram
Histograms represent brightness distribution in digital images. They help evaluate correct exposure. The y-axis represents the amount of pixels and the x-axis represents the brightness value.

### JPEG
A common image file format with two primary strengths – a relatively small file size and universal compatibility. JPEGs use a lossy compression scheme and should not be edited and re-saved.

### Noise
Statistical variations inherent in the sensor system cause noise. Noise is always present, but higher sensitivities and smaller sensors usually generate more noise.

### Pixel
Digital pictures consist of pixels, the smallest units. Each pixel has a color that can be represented by 8 or 16 bits or as a floating-point number (32-bit HDR).

### PPI
Pixels per Inch. Can be used to describe the actual pixels per inch of a print. Often confused with DPI (Dots per Inch), used by color printers to print an image.

### RAW File
A file containing the raw data from the camera sensor. RAW files do not have a color profile or other stylistic preferences permanently applied.

### TIFF
A comprehensive image format that offers lossless compression schemes for smaller file sizes with higher quality. This format is suitable for editing and printing but not publishing on the Web.

### Tone Mapping
Processing a 32-bit HDR image into an image that can be properly viewed on monitors and in prints.
Resources

You can find more tips, techniques, and regularly updated information in the Photomatix Pro FAQ on the HDRsoft website at http://www.hdrsoft.com/support/faq_photomatix.html.